MODUL LMS302 :
Easy Write with MS Word



MODULE OVERVIEW /INTRO

0 What is LMS 302 Module?

Microsoft Word offers a set of tools and
automated functions that can be of great help
when writing a thesis. From this module, students
and researchers will be able to produce draft
templates systematically and efficiently in
producing quality thesis.

Teaching Medium

1. Online via Webex, Google Meet, Google Classroom
2. Face to Face : IT Centre
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Q Module highlight :

Handling and demonstrate technique to:
1. Use important button in MS Word for
formatting

Duration
1 to 2 Hour(s)



MICROSOFT WORD?

* Used to make professional-quality documents, letters, reports, etc.,
MS Word is a word processor developed by Microsoft. It has
advanced features which allow you to format and edit your files and
documents in the best possible way.

*MS Word enables users to do write-ups, create documents,
resumes, contracts, etc. This is one of the most commonly used
programs under the Office suite.

* Microsoft Word is available for Microsoft Windows, Apple macOS,
Android, and Apple iOS. It can also run on the Linux operating
system using WINE.

[ ]| LBlpol Gt sl Deliayd
P Pembudayaan Ilmu
R Membentuk Adiwangsa




VESIREESE | Perpustakaan
UNIVERSITI ['un Abdul Razak
< TEKNOLOGI

@ ARA

* To create an MS Word doc, follow the steps mentioned above to open Microsoft
Word. Then once the program is open, click on “File” followed by “New”. This
opens a new doc where something new can be created.

* Since it is used by people of all age groups, in schools, in colleges and for official

purposes, having proper knowledge of Microsoft Word is a must. The preview of
the MS Doc file once it is opened is given below:

HOME INSERT DESIGM PAGE LAYOUT REFEREMNCES MAILINGS VIEW  VIEW v
= ot ibri AT B, = . 1= = 5= d Fina -
0 - Calibri (Body) - [11 - | A" A7  Aa- = = = = L 9T | paBbceDe AaBbccDe AabbCe acspbcel AAA B aasbcer acBbccoc  AaBBCCD: ab oo
Copsy ~| 25 Replace
Paste - = /Dy, - A - == = = = R o e R i i i 5 cic —
** Format Painter B r u abc M. X 2N Pl - Bll= = = | I= e ) T Mormal | T Mo Spac... Heading 1 Heading 2 Title Sulby Is
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COMMON ISSUES USING MSWORD

_ ! Many
Line spacing | Chapters

\

Correction
from SV’s

N

Assignment
page

QJ mbers
Rotation of
\pages
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STUDENT

GOOGLE

—~——

)

NoStudent
@student.uitm.edu.my

Username@uitm.edu.my

Example:
2021123456
@student.uitm.edu.my

Example:
ciksiti@uitm.edu.my

MICROSOFT

MICROSOFT

NoStudent
@isiswa.uitm.edu.my

. Example:
uitm.edu 2021123456
@isiswa.uitm.edu.my

Gmail Staff Gmail Student Google Manual Microsoft 365 Microsoft 365 Student Guide

Username
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HOW TO CREATE A TABLE OF CONTENTS IN
WORD

* A table of contents is just like the list of chapters at the beginning of
a book. It lists each section in the document and the page number
where that section begins. A really basic table of contents might look
like this:

Table of Contents

U 0T = AR .
U 0T = RPN .
U =T = PR s
U T =T AR - -
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Perpustakaan

STEP 1: APPLY HEADING STYLES

* If you apply a heading style, you're telling Word that you've started a new part of your
document. When you insert the table of contents, it will create a section for each heading. In
the table of contents above, each chapter uses a heading style, so there are four sections.

* To apply a heading style, select the text you want to format, then choose the desired heading
in the Styles group on the Home tab.

HOME IMNSERT DESIGHM PAGE LAYOUT REFEREMCES FAAILIMGS REVIEW VIEW
6 ~|A A Aa- B iZ-i=-%n- E3E AT | aapboede AsBbeede | AaBbCe| AaBbCcl
x, x° [~ W A ==== iév Ty - D5 . Thormal T Mo Spac... | Heading 'Ib Heading 2 |s
Faont Fa Paragraph M Styles fa
Chapter 1
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STEP 2: INSERT THE TABLE OF CONTENTS

* Now for the easy part! Once you've applied heading styles, you can insert your table
of contents in just a few clicks. Navigate to the References tab on the Ribbon, then
click the Table of Contents command. Select a built-in table from the menu that
appears, and the table of contents will appear in your document.
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DI Update Table

Table of
Contents =

Built-In
Automatic Table 1

Contents

Automatic Table 2

[able of Contents

IMSERT DESIGMN PAGE LAYOUT REFEREMCES MAILIMNGS

ABl ﬁ'} Insert Endnote E ,r:ﬁ,,l Manage Sources

AE, Mext Footnote — ER style: MLA -
Insert Insert

Footnote Citation - £ [ Bibliography - ¢
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* As you can see in the image below, the table of contents uses the heading styles
in your document to determine where each section begins. Sections that begin
with a Heading 2 or Heading 3 style will be nested within a Heading 1 style, much
like a multilevel list. A Brief History of the Roman Empire

Heading 1
_—'+The FOUNING OF ROME coiiiieievee s seeras s ss s e saeasssanes 3

Romulus and RemUs. ... s s 7

e —__+ The Seven Hills of ROME. i 11
The Old Kings of ROME v sesmss svnnsan 13

/’-I(!gdom 10 Republic. s 18

Heading 3

* A table of contents also creates links for each section, allowing you to navigate to
different parts of your document. Just hold the Ctrl key on your keyboard and
click to go to any section.

A Brief History of the Roman Fmnijre
Current Document

Ctrl+Click to follow link
The Founding of Hﬂmﬁj ...........................................

RoOmuUlus and Remite s essensesersmsenssnsrsnreasenss

]| Ldlusl G5t e Oellapid
] Pembudayaan Ilmu
Membentuk Adiwangsa

T'un Abdul Razak


https://edu.gcfglobal.org/en/word/lists/1/

STEP 3: UPDATE AS NEEDED

*If you edit or add to your document, it's easy to update the table of
contents. Just select the table of contents, click Update Table, and
choose Update Entire Table in the dialog box that appears. The table
of contents will then update to reflect any changes.

: [ 4 [ Update Table...

A Brief History of the Roman Empire

Update Table of Contents ?

The Founding of Rome........... ] ] e rnranne
Waord is updating the table of contents. Select one

Romulus and Remus.......... e SR |
! Update page numbers only

(®):Update entire tablei
The Old Kings of Rome .. OO -

Kingdom to Republic............. T | -

The Seven Hills of Rome.... —

LT T ..
The ROMan ConSTiTUTION .o s e rms s s rams s s s st s snn s s s s snsnnns 20
e T T L= - |-
=T T T o 4 O STO- 1

B I = L 0T ==,

Ldlyol Gyt sde Oellsyd
sif gemiud'a jicnﬂiﬁuﬂ The Catalline ConSPIraCIBS v saasras s sssnees 31
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STEP 1: FORMAT YOUR DOCUMENT USIN
HEADING STYLES

e Select each chapter in your document and apply Heading Styles to
them. Here, you are marking up the section headers so that Word can
recognize them.

* Go to Ribbon > Home > Styles. Select the text and apply headings for
all the text you want to include in the table of contents.

Sample Table of Contentsdocx - Saved to this PC

Review View Add-ins Help £ Tell me what you want to do 3 Share

= 24 ( AaBbCcDd AaBbCeDd AABDC( AaBbCcl AaB AaBbCcD AcBbCeDd AaBbCDd AoBbCcDd AaBbCeDe

Ran || 1| Lblnsl (st e Oeblsyd
F UKAS? Pembudayaan Ilmu
NERS Membentuk Adiwangsa




@ VARA

STEP 2: POSITION THE TABLE OF CONTENTS ON
THE PAGE

* Place the cursor on the specific position where you want the TOC to
appear in your document. This is commonly somewhere at the
beginning of the document.

DESREESE) | Perpustakaan
UNIVERSITI ‘ 1
« IEKNOLOGI

Ran || 1| Lblnsl (st e Oeblsyd
F UKAS? Pembudayaan Ilmu
NERS Membentuk Adiwangsa




LESIREESE) | Perpustakaan
UNIVERSITI un Abc Ra
. [TEKNOLOGI

@ \ARA

STEP 3: CLICK THE TABLE OF CONTENTS
COMMAND

* Go to Ribbon > References > ? e e S e e e A
Table of Contents. Choose T T e G B
from one of the two |

automatic types available. -

The only difference between ,T:
the two is the heading of -

"Contents" or '"Table of h:;r-;;:-rl-::;:;;
Contents" at the top. e —

Ran || 1| Lblnsl (st e Oeblsyd
UKAS? Pembudayaan [
NERS Membentuk Adiwangsa




VESIREESE | Perpustakaan
UNIVERSITI [un Abdul Razak
« )LOGI

TEKN(
@ VARA

STEP 4: THE TABLE OF CONTENTS IS INSERTED
AUTOMATICALLY

e Word scans the document and
uses the heading styles to
CO n St r u Ct t h e O rd e r Of t h e ln?rod:cllon: h(zlr;roi:lts\/\lord Add-Ins That Wlll-Make You More Productive Today................2

. o Sect! : Why are Microsoft Word Add-Ins Imporant? ........cccremneninmmsemmmmmemen &
sections and subsections and Seckon S How 13 et g Maraos MCIOM Wt ARG e
° ° ° Download add-ins from the OffiCe SUOMe.........c.ccueeeerieeereiriseeeesrsassesssssssessssnsasssssssesssssnnssss Bl

t h e I r pa ge n u m be rS o Th I S I S a Download add-ins from inside MICrosoft WOord ..........ccceviimnimmmennnsnsnsnnesssnsssssesssensssendd
Delete the add-in you don 137 1| S - 5

b b TO C d Seclion 4: The best free Microsoft Word add-ins for everyday productivity ...........ccceevenneend
a re Ones a n you Ca n WV IRING ASBISUINL: .. oo dvsnmagvnsanyrasosssionsussnsssnxpmsis sy aaf s Fne sasovinau s snas s Ty ons s men aAs s RaAsma 5

2. MySCript Math SBMIG. .......cneemscmmanisaasssaresnasnsssnisssusassssasesnassansnsnasssnanessssusanssssmmssonasss 6

continue to work with this and 3, Ay GGUOT v ;
4. ' ShOUD B8 WIING ..:..ccviiniisiiissvissassssissosssisssssssivsoss siimaissssssdsimivsssssivasisasnsysritassissas 7

make it more stylish. s )

L DO S B RIOY i e B G G RS R e A e ebias wovosisvmiisiascsns 0
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STEP 5: UPDATE THE TABLE OF CONTENT
ANYTIME

* You can always update a Table of S+ 0) %

Contents_ that has been Create.d “ Home Insert Draw Design Layout References
automatically. Update the table if

_ D ) Add Text ~ . i
you change the heading styles, S!Updamab,e gl 38 PeemErte }D @

ab; Next Footnote ~

rearrange the ContentS’ Or Change Table of @ Insert i Smart Researcher
.. Contents ~ Footnote | Lookup
the text. AISO’ Update It If you Table of Contents Footnotes M Research
make any changes to the content . Ubickits Tkt 1
that affects the page numbers. . Refresh the table of contents so al
entries refer to the correct page
* To update a table of contents that aumber,

was created automatically,
click References > Update Table.
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* Choose to Update page numbers only or Update entire table if you
want to update the page numbers and the text.

Update Table of Contents ? X

Word is updating the table of contents. Select one of the following
options:

O Update page numbers only

----------------------------------------------------------

........................................................

OK Cancel
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STEP 6: CREATE A TABLE OF CONTENTS
MANUALLY

* When the automatic method is so effortless, why would you feel the
need to make one manually? There could be two reasons:

* The document is without any styles which Word can recognize.
*The document has too much of variety makes an automatic TOC
difficult.

* To create a manual table, go to References > Table of Contents > Click
the dropdown to reveal the option for Manual Table.
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HOW TO CUSTOMIZE THE TABLE OF
CONTENTS

*You can easily customize a TOC
with the Table of Contents dialog
box. Go to References > Table of
Contents > Custom Table of
Contents to launch the dialog.
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STEP 1: CHOOSE A DIFFERENT FORMAT FOR
THE TOC

*You can change an entire table by choosing a different format. In
the General section, expand the dropdown for Formats and choose an

appearance.

General

Formats: From template s

Show levels: :
Classic

Distinctive
Fancy
Maodern
Formal
Simple
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STEP 2: CHANGE THE APPEARANCE OF
THE ITEMS IN THE TOC

* Remember, the appearance of your TOC is ultimately controlled by style
definitions. You may want to tweak the overall look of the TOC by creating your
own styles for the headings. These modified styles can be saved alongside the in-
built ones and applied across the document for a consistent look. Follow these

steps.
* Click Modify. If the Modify button is grayed out, change Formats to From
template.
Formats: From templat
Show level
Qptions... Modify... ‘
OK C
RaA |[ 2 || Wbl Gt o Dol
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. . Style ? X
* In the Styles list, click the
|eve| that yOU Want tO Please select the appropriate style for your index or table entry
change and then 5:;'2"’1
. . New...
click Modify. Here, TOC 1 ‘
corresponds to heading Y Bl
level 1 in your document, Y ¥oga
TOC 2 to heading level 2, T Toc 6
. TOC 7
TOC 3 to heading 3 and T TOC 8
SO on T10c 9
’ Preview
Arial vipt | Modify. |

Space @ |

After: 5 pt, Style: Automatically update, Hide until used, Priority: 40
Based on: Normal
Following style: Normal

OK Cancel
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*In the Modify Style dialog Modify Style ? X
box, you can change the font Properties
or its color. Make any other S0 ek
. . Style type: paragraph v
formatting change like text i e =
indentation and then click OK. R P U | — o
* Before you click OK, you can Formatting
choose whether the style aalook [0 M| B I U |
change applies to the current E| = = | = = = |{3 2| @ =
document or to all future
documents. To save it for Sample Text Sample Text Sample Text
future use, click the checkbox Sample Text Sample Text Sample Text
for Add to the Styles gallery. Sample Text Sample Text Sample Text

Sample Text Sample Text Sample Text

Font: Anal Black Font color: Accent 2, Space
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STEP 3: CHANGE THE LEVELS OF THE
STYLE HEADINGS SHOWN

* A TOC can be itemized, or you can just include the major sections. The Show
levels number allows you to change the number of levels displayed in your table
of contents. The “Levels” here refers to the style headings you have applied to

your sections.

* For instance: H1, H2, H3... etc. If you set it on 2, then all text with the Heading 1
style or the Heading 2 style is displayed.

General

Formats: Distinctive

-

Show levels: 3 -

O
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STEP 4: CHANGE OR ADD DOT LEADERS IN THE
TOC

* Dot leaders are the lines or dots that connect the items in the index to page
numbers. These leader lines are mentioned in many style guides as a necessary
part of thesis documents.

* In the Table of Contents dialog box, click the dropdown for the Tab leader list
and select the dotted line option. Alternatively, choose the leader line you want
or select “none” to remove it from the TOC.

Show page numbers Use hyperlinks instead of page numbers
Right align page numbers

Tab leader:

General

Formats:

Show levels: 3

Options... Modify...
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STEP 5: ADD A NON-HEADING STYLE

* Word won’t include a non-heading
style when it inserts an automatic
TOC. By default, Word only includes B bl of G

Print Preview

headings 1 through 9. But it gives ' [ 1 sssbeoonmsbon

Styles

Table of Contents Options ? X

you a method to include any other || reno 3 s sl
style you create in the index. Let’s eading 3 u L |

say you want to add another heading = G o Y e

called “A Brief Guide” at the top of === s

the content and the TOC. )

General

Formats: From template v D Table gntry fields

*In the Table.of Contents dialog bo>_<, | o, =
click the Options button to open this

screen: Modify...

OK Cancel

Cancel
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* Right now, it maps the styles in use only to the TOC levels. As you can see, the three
styles, Heading 1, Heading 2, and Heading 3 are mapped as levels 1. 2, and 3.

* Go down the boxes until you find Title, which has no mapped TOC level. Enter 1 to
map Title to the TOC top level.

Table of Contents Options

Build table of contents from:

Styles

2vaillable styles: TOC level:
Heading S
Heading ©
Normal
Subtitlie
L Title
TOC Heading >
Outline levels

:] Table entry fields

Reset l OK I Cancel

* Click OK twice to exit the dialogs. Word will prompt you to replace the contents.
Click Yes to replace the TOC.
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STEP 6: CREATE A CLICKABLE TABLE OF
CONTENTS

 Creating a hyperlinked Table of Contents is expected in the digital age. Navigation is
faster. It is also another condition to submit a thesis or dissertation.

* Click the Use hyperlinks instead of page numbers checkbox.
* Also, uncheck the Show page numbers box if you just want to use the hyperlinks.

Table of Contents 7 >

' Table of Qonténts -

Print Preview Web Preview

Heading 1 ..o 1 & Heading 1 |~
Heading 2. ... 3 Heading 2
Heading 3 .....cccccocamasmesnnnas S5 Heading 3
Lo S
[Zf Show page numbers [ZI Use hyperlinks instead of page numbers
[+7] right align page numbers “:j
Tabk leader: R
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STEP 7: PLACE A SIMPLE BORDER AROUN
THE TABLE OF CONTENTS

* You can use Word’s Shapes feature to insert a border around the TOC. Set Shape
Fill to “No Fill” and then add Shape Styles or use Format Shape to design the look
of the pseudo-border around the table.

Table of Contents

Ran ([ 8 ]| Ldlnsl Gsat e Oeblssd
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HOW TO CREATE AND CUSTOMIZE A TABLE OF
FIGURES IN WORD

* When you create a document with many pages and sections, you might use a Table
of Contents to help your reader navigate. So if your document includes tables and
figures, a Table of Figures serves the same purpose. This table allows your reader to
jump directly to one of these objects.
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STEP 1: ADD CAPTIONS TO YOUR TABLES AND
FIGURES

* Before you can insert a Table of Figures in Word, ensure that all of
your items have captions. These are what allow the table to find and
display them.

*You can select, right-click the table or figure, and choose Insert
Caption. This allows you to label the item as a table or figure and give
it a number or letter. So you can use Table A, Figure 1, etc.
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Caption groovyPost.com ? >
Caption:
Table A
O ptions
Label: Table ot
Position: Below selected tem St

|:| Exclude label from caption

MNMew Label... Delete Label rMRMumbering...

AutoCaption... I ] L I Cancel
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e The Table

of

Figures

window will display. This is
where you customize the
appearance of the table.
First, confirm that the Table
of Figures tab is selected at

the top.

* The top of the window is
divided into two sections:
Print Preview and Web
Preview. Each of these
offers customization or two
of its own. Work with the

one on your
view.
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Table of Figures ? >
Index Table of Contents Table of Eigures Table of Authorities
Print Preview Web Preview
Table A: TeXt..cciiiieiiiirececnrrnenanannas 1|\~ Table A: Text =
Table B: TeXT cuviieieiieininensasensnsnns 3 Table B: Text
Table C: TeXt..iiiiiiieireisasanannnsansnns 5 Table C: Text
Table D: TeXt ..cuiiiieiriisasaansanansannans 7 Table D: Text
Table E: TeXtuuuuueeueueainreeeaeannenns 10 Table E: Text
W W
Show page numbers Use hyperlinks instead of page numbers
Right align page numbers
Tak leader: | ... e
General
Formats: From template s
Caption label: 2
Include label and number
Options... Moadify...
groovyPost.com oK Cancel




*Print Preview: You can show
the page number and/or right
align to those page numbers by
checking the corresponding
ooxes. If you use both, you
nave the option to select a Tab
eader in that drop-down box.
This lets you use dots, dashes,
or lines between the label and
the page number.
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Print Preview

Table A: Text -———-————--

Table B: Text ------———---
Table C: Text-----

Table D: Text ------------

Table E: Text-----

Show page numbers
Right align page numbers

Tab leader; | -—-----

] —
oF




*Web Preview: You can check
the box to use hyperlinks

instead of page numbers for Web Preview

this view. And it's obviously a Table A: Text

helpful way to navigate to the Table B: Text

table or figure with a simple '

click. Table C: Text
*Next, move down to the Table D: Text

General section of the window Table E: Text

for additional customization

OPtiOHS. ~'| Use hyperlinks instead of page numbers

o <
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* Formats: Various formats are Genera

available to pick from, each Formats: From template v
with a slightly different look Caption label; ML

and feel. You can select one to T include labe] Distinctive

match your document or one Esprtifd

that’s simple or formal. P Simple

* If you prefer to create your own table formatting with specific fonts,
you can modify the Table of Figures template. First, select From
Template under Formats and then click the Modify button. Just note
that you will be changing the default template for that object.
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* Label: This is a key element of the Table of Figures. Be sure to select the
type that matches your items. For example, you can pick Equation,

L]
Figure, or Table.
Index Table of
Style ? ey

Print Preview
Figure 1: Text Please select the appropriate style for your index or table entry -~
Figure 2: Text | 3vles

. Table of Figures | | pnlaw
Figure 3: Text - =

.
Figure 4: Text Delete
Figure 5: Text

L
Show page numbe umbers
Right align page n
Tab leader: | ...
Preview

General +Body 10 pt Modify...

Formats: Frd |Font: 10 pt, Bold, Indent: ~

. ] Left: 0"
Caption label: | Fig Hanging: 0.31", Space
nclude label and After: 0 pt Style: Hide until used, Priority: 100 h
Ok Cancel Modify...
Lt iyl it pde Oells groovyPost.com oK Cancel
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* Include the label and number: This is an optional checkbox and depends on the
text you include with your caption. For instance, if you only want the caption text to

display rather than the label and its number, uncheck this box. Here’s an example to
illustrate the difference.

* We have two figures with the captions as “Figure 1 Daisies” and “Figure 2
Roses”. With the box checked, they display exactly like that in the Table of Figures

because we include the label and number. With the box unchecked, you only see
the text in the table, Daisies, and Roses.

EFEY 0% jt i - !
Box checked r_-l OOV
2T A R — 2
FIELINE 2 RSB tuveunnnsrnsnnnnnsnrnsnsssnsssssssssussessssssssssssssssssssssssssssssssssssssssssssssnsssssssssssssss s ssssssssssssessss s ssssssmssssss e 3
Box unchecked
1T T T PR, 2
3T 3
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* When you finish selecting all the options for your Table of Figures, click OK to insert
it into your document.

groovy Post.com
Tl B i sssenunnssnmnnnnsnnssnsnssssssnsssnsssnssssssssssssssssensss s ssssss s sssssssssssssssssssssssssssssssssssssssnssssesnssons s es oo on s A
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HOW TO UPDATE A TABLE OF FIGURES

* If you insert a Table of Figures and then add or remove figures or tables or edit the
captions, you can update the table to reflect your changes.

1.
2.

Select your Table of Figures.

Go to the References tab and click Update Table in the Captions
section of the ribbon.

. Choose to either Update the Page Numbers Only or Update the

Entire Table.
Click OK.
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Ijll] [ Manage Sources
\/

[ 17 style: APA v
Insert o
Citation ~ L3 Bibliography ~

Citations & Bibliography
T P T

groovyPost.com

Insert Table of Figures

&

Update Table of Figures

Gpﬂﬂﬂi

l:::l Update entire table

Word i1s updating the table of figures. Select one of the following

! |
Insert |[3 Update Table
Caption E-E Cross-reference
Captions
I S R BT
? >

Ok Cancel

You should then see your table update with the new items you added and any

other changes you made to the captions.
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HOW TO ADD PAGE NUMBERS

* Page numbers can be used to automatically number each page in
your document. They come in a wide range of number formats and
can be customized to suit your needs. Page numbers are usually
placed in the header, footer, or side margin. When you need to
number some pages differently, Word allows you to restart page
numbering.

* Word can automatically label each page with a page number and
place it in a header, footer, or side margin. If you have an existing

header or footer, it will be removed and replaced with the page
number.
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STEP 1
* On the Insert tab, click the Page Number command.
l By j J L 4 A | # Signature Line ~

D Date & Time
Header Footer Pag-: Text Quick WordArt Drop )
d * Number= Box~- Parts~ - Cap~ ] Object ~
Header &F [# Top of Page Y Text

- z| Bottom of Page ¥

=] Page Margins ¥

i’ Current Position b

EI'E Format Page Numbers...

F;.; Remove Page Numbers
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S I E P ! i 2 Tell me what you want to do...
W '""_‘ ,_'-—:E,H;.'ptrllnk TI' | [=T Iy | 1 | . 4
fm & e l + _—

= |"" Bookmark

.« Wikipedia Online Comment Header Footer  Page Text Quick WardArt
Video ) Cross-reference - -~  Numberr Box~ Parts~
*Open the Top of | | =[P Topetpge :
Page X [z Bottom of Page g

Page, Bottom of ... B Page Margin

Page, or  Page o
Margin menu, B Bemove Page Number
depending on where ™
you want the page
number to be L Page X of ¥ Inited States
positioned. Then ——% feating

select the desired . ey
style of header. poetry and

] I} Lalh isee, 15 the

r missed an

! Page a1 e editors of
I wm 115 editors,
F Mare Page Mumbers from Office.com ,
iters that
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STEP 3

* Page numbering will appear.
R TR TR BRI ORI B

ountam at the Unmiversity of the South in Sewanee, | ennessee, 1s the
Few. Founded in 1892, the Sewarnee Review (5R) has never mssed an

he oldest continuously published quarterly review in the United States
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STEP 4

* Press the Esc key to lock the header and footer.

0 700

Andrew Lyvitle ar The Sewanee Review

ountain at the University of the South in Sewanee_ Tennessee, 15 the
iew. Founded in 1892, the Sewanee Review (SR) has never missed an

he oldest continuously published quarterly review in the United States

* If you need to make any changes to your page numbers, simply
double-click the header or footer to unlock it.
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HOW TO ADD PAGE NUMBERS TO AN
EXISTING HEADER OR FOOTER

*If you already have a header or footer and you want to add a page
number to it, Word has an option to automatically insert the page
number into the existing header or footer. In our example, we'll add
page numbering to our document's header.
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STEP 1:

* Double-click anywhere on the header or footer to unlock it.

Y SRR R SRR BRI SURCREE. S A

].---|---§---|---1---|---2---|---3---|--

| Andrew Lytle at The Sewanee Review
December 21, 2015

Atop Monteagle Mountain at the University of the South 1n Sewanee, Tennessee, 1s the
office of The Sewanee Review. Founded in 1892, the Sewanee Review (SR) has never missed an

1ssue, distinguishing it as the oldest continuously published quarterly review in the United States.
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STEP 2:

*On the Design tab, click
the Page
Number command. In
the menu that appears,
hover the mouse
over Current
Position and select the
desired page
numbering style.

L lysl Byt sde Osllasd
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Header & F B Top of Page p [Tt MNavigation )
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[¢] Current Position * Simple -
Eh Format Page Mumbers... Plain Number
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STEP 3:

* Page numbering will appear.

'E"'I"'l"'l"'l' I 3 I 4 1 5 1 B d T
| Andrew Lytle at The Sewanee Review Page |1
December 21, 2015
""""""""""""""""""" dndrew Lyvtle at The Sewanee Review |

Atop Monteagle Mountain at the University of the South 1n Sewanee, Tennessee_ 1s the
office of The Sewanee Review. Founded 1n 1892, the Sewanee Review (SK) has never missed an

1ssue, distinguishing i1t as the oldest continuously published quarterly review in the United States.
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STEP 4:

* When you're finished, press the Esc key.
-E---.---1---.---z---.---3---.---4---.---5---.---

(=31
L=
=l

December 21, 2015

Andrew Lyvtle at The Sewanee Review

Atop Monteagle Mountain at the University of the South 1n Sewanee, Tennessee, 1s the
office of The Sewanee Review. Founded 1n 1892, the Sewanee Review (SR) has never missed an

1ssue, distinguishing 1t as the oldest continuously published quarterly review in the United States.
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HOW TO HIDE THE PAGE NUMBER ON
THE FIRST PAGE

*In some documents, you may not want the first page to show the
page number. You can hide the first page number without
affecting the rest of the pages.
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STEP

* Double-click the header or footer to unlock it.

* From the Design tab, place a check mark next to Different First Page. The
header and footer will disappear from the first page. If you want, you can
type something new in the header or footer, and it will only affect the first

page.

ers_Practice - Word Header & Footer Tools

Mailings Review View Design

r| Elq Previous ifferer'lt First Page

Elp Mext Different Odd & Even Pages
Goto Goto

B el e e Link to Previous v| Show Document Text

Mavigation Options
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HOW TO RESTART PAGE NUMBERING

* Word allows you to restart page numbering on any page of your
document. You can do this by inserting a section break and
selecting the number you want to restart the numbering with. In
our example, we'll restart the page numbering for our
document's Works Cited section.

tRan [ ]| Lol (st e Oellsyd
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STEP 1:

*Place the insertion point at the top of the page you want to restart
page numbering for. If there is text on the page, place the insertion
point at the beginning of the text.

R N T Y S B S B SR

- Works Cited

otte. The Fugitive Legacy: A Critical Historv. Baton Eouge: LSU Press, 2001.

e. " Remaking The Sewanee Review.” Chattahoochee Review 8 (1988): 71-7.

vanee Review: A Critical and Editorial History.” Sewanee: University of the South
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STEP 2:

*Select the Layout tab, then
click the Breaks command.
Select Next Page from the
drop-down menu that
appears.
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File Home Insert Design

—_—

B O E

Margins Orientation Size Columns

- - - -

Page Setup
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@ )ARA
Layout References Mailings Revi
"= Breaks ~ Indent Spacing
Page Breaks

|

b

=

B

2

BTG

Page
Mark the point at which one page ends
and the next page begins.

Column

Indicate that the text following the column
break will begin in the next column.

Text Wrapping

Separate text arcund chjects on web
pages, such as caption text from body text,

Section Breaks

-

2T IR [V

Next Page
Insert a section break and start the new
section on the next page. l:}

Continuous
Insert a section break and start the new
gection on the same page.

Even Page
Insert a section break and start the new
section on the next even-numbered page.

Odd Page
Insert a section break and start the new
section on the next odd-numbered page.

=l
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STEP 3:

e A section break will be added to the document.

* Double-click the header or footer containing the page number you
want to restart.

Works Cited same as Previous

Legacy: A Crtical History. Baton Rouge: LSU Press, 2001.

sewanee Review ™ Chattahoochee Review 8 (1988): 71-7.

ritical and Editorial History.” Sewanee: University of the South
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* Click the Page Number command. In the menu that appears,
select Format Page Numbers. ,
File Home Insert Design Lay
]
O DN B a4
Header Footer | Page Date & Document i;II
- *  MNumberr Time Info~ L&
Header & F & Top of Page b
= [#] Bottom of Page b
k] Page Margins b
[#] Current Position b
= Eb'E| Format Page Numbers...
. Es'.; Eemove Page Mumbers
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STEP 5:
* A dialog box will appear. Click the Start at: button. By default, it will
start at 1. If you want, you can change the number. When you're

done, CIICk OK' Page Mumber Format 7 =

Mumberformat: 1, 2, 3, ...

e’

|:| Include chapter number
Chapter starts with style: | Heading 1
- [hyphen)

11, 1-A

Use separator

Examples

Page numbering

l:::l Continue from previous section
FS

(@) Startat |1 =

3

n]4 Cancel
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* The page numbering will restart.
| o+ Fooc o o4 . 5 | g A 7
Page |1
----------- T-‘.'url.;gcltgd Same as Previous
_egacy: A Cntical History. Baton Rouge: L5SU Press, 2001.
Sewanee Review.” Chattahoochee Review 8 (1988): 71-7.
ritical and Editorial History.” Sewanee: University of the South
bl ga! Gy 3ells o8
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HOW TO CREATE A BIBLIOGRAPHY OR
WORKS CITED PAGE IN WORD

* If you need to write a research paper, chances are you'll also be required to
include a bibliography. Or you might be asked to include a works cited page or
a list of references. These are all just different names for the same thing: a list
of sources—such as books, articles, or even websites—that you used to research
and write your paper. A bibliography makes it easy for someone else to see where
you found your information. A short bibliography might look something like this:

Works Cited

Core, George. The Sewanee Review: A Critical and Editorial History. Sewanee: The Umiversity
of the South, 2008.

Fitzgerald, Sally. Flammery O'Connor: The Habit of Being. New York: McGraw Hill, 1979,

Janssens, G.A M. The American Literary Review. The Hague: Mouton, 1968,
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STEP 1: CHOOSE A REFERENCF STYI F

* When you're creating a bibliography, you'll need
to follow the guidelines of the required style
guide. Different academic disciplines use their
own styles guides, such as MLA, APA,
and Chicago. Fortunately, Word comes with
several built-in style guides; all you need to do
is select the one you want to use, and Word will
help you format your bibliography correctly.

* To do this, click the References tab, then select
the desired style in the Citations &
Bibliography group.

* You can use this same method to change the
reference style at any time.

1] Wbl Bt o Oellayd
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REFEREMCES

_ ,r_ﬁl,,[ﬂanaqe Sources
v

MAILINGS REVIEW VIEV

Insert

ER style: | APA

.'|.|'
|;‘—| D Insert Table
| PN

Citation = = [ Bibliog

Citations & Biblix

APA TE
Sinth Edition

Chicago

Sixteenth Edition

GB7714

GOST - Name Sort

GOST - Title Sort

Harvard - Anglia

IEEE le
IS0 690 - First Element and Date
1937

IS0 690 - Numerical Reference [;

1987
MLA t:

Seventh Edition I}

SISTOZ2 x
Turabian -
Sith Edition

2553 | Perpustakaan



STEP 2: ADD CITATIONS AND SOURCES

* Whenever you use information from one of your sources, you'll need to give
credit—or cite them. This is known as making a citation. You'll include citations
whenever you use information from a source or when you quote a source directly.

* To add a citation, select the desired location for the citation in your document,
click the Insert Citation command on the References tab, and select Add New

Source.
FEFEREMCES RAAAILINGS F.ENITEW
t!f]..—"' ,'_:ﬁl.l.l"-ﬂanage SOUrces — Ea
E% Style: | MALA - —
Insert = o Insert
Citation - = Bibliography ~ Caption 34

LE] Add New Source...

*»  Add Mew Placeholder...
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* A dialog box will appear. Enter
the requested information for
the source—like the author
name, title, and publication
details—then click OK.

[] corporate Author
Title |The American Literary Review
Year (1963
City | The Hague
Publisher Mouton
Medium

|:| Show All Bibliography Fields
Tag name Example: Documen t

GAMES T

2
Create Source :
Type of Source | Book w
Eibliography Fields for MLA
Author | G.AM. Janssens Edit

1] Wbl Bt o Oellayd
. Pembudayaan Ilmu
Membentuk Adiwangsa

* The citation will appear in the
document, and the source
will be saved. You can quickly
add another citation for the
source by clicking Insert
Citation and selecting the
source from the drop-down

menu. REFEREMNCES MAILINGS

‘ _Ij ,r:ﬁuli Manage Sources

[% Style: |MLA -
Insert . o
Citation = =4 Bibliography ~ :

lanssens, G.A.M.

The American Literary
Review, (1968) L}

LE Add New Source...

[ Add Mew Placehalder...
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STEP 3: INSERT THE BIBLIOGRAPHY

* Time for the easy part! Once you've added all of
your sources, you can create your bibliography in
just a few clicks! Just select
the Bibliography command, then choose the
desired style.

* If you add more sources to your document, you
can easily update your bibliography—just click it
and select Update Citations and Bibliography

: £y~ [ Update Citations and Bibliography
Works Cited

Core, George. The Sewanee Review: A Critical and Editorial History. Sewanee: The University
of the South, 2008.

Fitzgerald, Sally. Flannery O'Connor: The Habit of Being. New York: McGraw Hill, 1979.

Janssens, G.A M. The American Literary Review. The Hague: Mouton, 1968,
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REFEREMCES

@

MAILINGS REVIEW

|;| [} Insert Table of Figures

VIEW

@Manage Sources

ERl Style: [MLA -
Insert - Insert
“itatian - £ (4 Bibliography ~ Caption Ej Cross-reference

Citatic Built-In
Bibliography
Bibliography

Chen, Jacky. Citations amd Refermee:. New York: Contoso Press, 2008
Haas, Jomtlen Creafimg a Formal Pableation. Bestone Prosewans, ., 2005,
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Mark
Entry

Eramer, James vl How o Wrire Sibliogprapiies. Chicage: Adveoture Works Press, 2006,

References

References
Chen, Jacky. Citations and Refenmees. Mew York: Conloso Presa, 2003
Haas, Jomtlsn Creanmge o Formal Publicarion, Bestooe Prosewans, e, 2003,

Kramer, James Davil fow to Brite iblioprapiies. Chicage: Adverfure Works Press, 2006,

Works Cited

Works Cited

Chen, Ja.uk)'. it ey aumed Mmmm Mew York: Conloso Prosa, 20003
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Kramer, James Davel fow to Brite Siblioprapiies. Chicage: Adveriore Works Press, 2006.
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Consultation Services:

Main Library : 03-5544 3793
Law Library : 03-5544
3733

Science & Technology Library : 03-5544 3820
Engineering Library : 03-5544 3812

Built Environment Library : 03-5544 4392

. . . Need help? x
Ch at Wlth LI b rarian : Our Librarian on Duty is ready

https://ptar.uitm.edu.my/libchat B

Like and follow us at social media:
https://twitter.com/uitmlibrary
https://www.instagram.com/libraryuitm/
https://perpustakaanuitm.blogspot.com/
https://www.facebook.com/libraryuitm/



https://ptar.uitm.edu.my/libchat
https://twitter.com/uitmlibrary
https://www.instagram.com/libraryuitm/
https://perpustakaanuitm.blogspot.com/
https://www.facebook.com/libraryuitm/

o
e

MARA

USER EDUCATION TEAM

MUHAMMAD AZRUL NIZAM BIN ABDUL RAHMAN

EZA ELIANA HJ ABDUL WAHID LIBRARIAN

SENIOR LIBRARIAN

RESEARCH SUPPORT UNIT

RESEARCH SUPPORT UNIT TUN ABDUL RAZAK LIBRARY

TUN ABDUL RAZAK LIBRARY

03-5544 3736

03 e azrulnizam@uitm.edu.my

eza080@uitm.edu.my

UITVEEEE s 55 - Lews|

@ @perpustakaanuitm @libraryuitm ® @libraryuitm @ @perpustakaanuitm @ @perpustakaanuitm



USER EDUCATION TEAM (FACULTY LIBRARIES) I e

SITI ROHAYU BINTI MOHAMAD YUSOF
SENIOR LIBRARIAN

TUN ABDUL RAZAK LIBRARY
(BUILT ENVIRONMENT)

03-5544 4392
sitirohayu@uitm.edu.my

MOHD HAZRUL BIN MOHD HUSSIN
SENIOR LIBRARIAN

TUN ABDUL RAZAK LIBRARY
(SCIENCE & TECHNOLOGY)

03-5544 3811
hazrul@uitm.edu.my

UITVEEEE s 55 - Lews|

MARA

MASNIDA HANIM BINTI ROJIKIN
SENIOR LIBRARIAN

TUN ABDUL RAZAK LIBRARY
(ENGINEERING)

03-5544 3812
idahanim@uitm.edu.my

HANANI BINTI ROJIKIN
SENIOR LIBRARIAN

TUN ABDUL RAZAK LIBRARY
(LAW)

03-5544 3738
hanani_rojikin@uitm.edu.my

@ @perpustakaanuitm @libraryuitm ® @libraryuitm @ @perpustakaanuitm @ @perpustakaanuitm



L
O
<
<
a
<
L
-
<




o

SCAN ME




THANK YOU

PERPUSTAKAAN TUN ABDUL RAZAK, UiTM



	Default Section
	Slide 1
	Slide 2
	Slide 3: MICROSOFT WORD?
	Slide 4
	Slide 5: Common issues using MS Word
	Slide 6
	Slide 7: HOW TO CREATE A TABLE OF CONTENTS IN WORD
	Slide 8: STEP 1: APPLY HEADING STYLES
	Slide 9: STEP 2: INSERT THE TABLE OF CONTENTS
	Slide 10
	Slide 11: STEP 3: UPDATE AS NEEDED
	Slide 12: STEP 1: FORMAT YOUR DOCUMENT USING HEADING STYLES
	Slide 13: STEP 2: POSITION THE TABLE OF CONTENTS ON THE PAGE
	Slide 14: STEP 3: CLICK THE TABLE OF CONTENTS COMMAND
	Slide 15: STEP 4: THE TABLE OF CONTENTS IS INSERTED AUTOMATICALLY
	Slide 16: STEP 5: UPDATE THE TABLE OF CONTENTS ANYTIME
	Slide 17
	Slide 18: STEP 6: CREATE A TABLE OF CONTENTS MANUALLY
	Slide 19: HOW TO CUSTOMIZE THE TABLE OF CONTENTS
	Slide 20: STEP 1: CHOOSE A DIFFERENT FORMAT FOR THE TOC
	Slide 21: STEP 2: CHANGE THE APPEARANCE OF THE ITEMS IN THE TOC
	Slide 22
	Slide 23
	Slide 24: STEP 3: CHANGE THE LEVELS OF THE STYLE HEADINGS SHOWN
	Slide 25: STEP 4: CHANGE OR ADD DOT LEADERS IN THE TOC
	Slide 26: STEP 5: ADD A NON-HEADING STYLE
	Slide 27
	Slide 28: STEP 6: CREATE A CLICKABLE TABLE OF CONTENTS
	Slide 29: STEP 7: PLACE A SIMPLE BORDER AROUND THE TABLE OF CONTENTS
	Slide 30: HOW TO CREATE AND CUSTOMIZE A TABLE OF FIGURES IN WORD
	Slide 31: STEP 1: ADD CAPTIONS TO YOUR TABLES AND FIGURES
	Slide 32
	Slide 33
	Slide 34
	Slide 35
	Slide 36
	Slide 37
	Slide 38
	Slide 39
	Slide 40: HOW TO UPDATE A TABLE OF FIGURES
	Slide 41
	Slide 42: HOW TO ADD PAGE NUMBERS
	Slide 43: STEP 1
	Slide 44: STEP 2
	Slide 45: STEP 3
	Slide 46: STEP 4
	Slide 47: HOW TO ADD PAGE NUMBERS TO AN EXISTING HEADER OR FOOTER
	Slide 48: STEP 1:
	Slide 49: STEP 2:
	Slide 50: STEP 3:
	Slide 51: STEP 4:
	Slide 52: HOW TO HIDE THE PAGE NUMBER ON THE FIRST PAGE
	Slide 53: STEP
	Slide 54: HOW TO RESTART PAGE NUMBERING
	Slide 55: STEP 1:
	Slide 56: STEP 2:
	Slide 57: STEP 3: 
	Slide 58: STEP 4:
	Slide 59: STEP 5:
	Slide 60: STEP 6:
	Slide 61: HOW TO CREATE A BIBLIOGRAPHY OR WORKS CITED PAGE IN WORD
	Slide 62: STEP 1: CHOOSE A REFERENCE STYLE 
	Slide 63: STEP 2: ADD CITATIONS AND SOURCES
	Slide 64
	Slide 65: STEP 3: INSERT THE BIBLIOGRAPHY
	Slide 66
	Slide 67
	Slide 68
	Slide 69
	Slide 70
	Slide 71


